LEXMARK

X215 MFP

User’s Guide

April 2003



http://www.lexmark.com

Edition: April 2003

The following paragraph does not apply to any country where such provisions are inconsistent with local law: LEXMARK
INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this
statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein;
these changes will be incorporated in later editions. Improvements or changes in the products or the programs described may be made
at any time.

Comments about this publication may be addressed to Lexmark International, Inc., Department F95/032-2, 740 West New Circle Road,
Lexington, Kentucky 40550, U.S.A. In the United Kingdom and Eire, send to Lexmark International Ltd., Marketing and Services
Department, Westhorpe House, Westhorpe, Marlow Bucks SL7 3RQ. Lexmark may use or distribute any of the information you supply in
any way it believes appropriate without incurring any obligation to you. You can purchase additional copies of publications related to this
product by calling 1-800-553-9727. In the United Kingdom and Eire, call +44 (0)8704 440 044. In other countries, contact your point of
purchase.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make these available in all
countries in which it operates. Any reference to a product, program, or service is not intended to state or imply that only that product,
program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any existing intellectual
property right may be used instead. Evaluation and verification of operation in conjunction with other products, programs, or services,
except those expressly designated by the manufacturer, are the user’s responsibility.

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United States and/or other
countries.

Operation ReSource is a service mark of Lexmark International, Inc.

Other trademarks are the property of their respective owners.

© 2003 Lexmark International, Inc.

All rights reserved.

UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer software and
documentation developed exclusively at private expense.

Copyright advisory

It may be illegal to copy certain materials without permission or license, including documents, images, and currency. If you are not sure
whether you have permission, seek legal advice.



' Contents

\V -

Chapter 1: Getting Started..........cooovviiiiiiiiiiieeeei e 7
Understanding the PartS .........cocooioiiiiiiiiiie e e e ee e 8
FrONt VIBW ...oooiiiiiiiiic 8

REAI VIBW .. 8

LU T 0= T 4 o PP 9
Installing the toner Cartridge ..., 11
Connecting the cables............. 13
Powering on the maching..........cccooioiiiiiii e 14
Understanding the operator panel ............ccccccciiviiiiiiiiiiiiiiiiiieieeeeeeee e, 15
Settingthe date and time ... 16
Changing the display language............ccccce i, 16
Setting the COUNLIY ..o s 17
Setting the station ID ... ———— 17
Setting the Power Saver MOde.........ccooovviiiiiiiii e, 18
Chapter 2: Installing software.........cccccveiiiieeiieeeice e 19
INStalling the ArVEIS ......uviiiiiiiiee e 19
RemoviNg the driVEIS ......coooii i ae e 20
Chapter 3: Loading paper and changing paper size................. 21
Selecting print materialS............ccco i 21
Guidelines for paper and specialty media ...........cccccvvviiiiiiii 22
Loading the paper tray .......coooeoiiioi e 24
Loading the manual BYPass ........ccooooiiiiiii e 28
Setting the paper type and SiZe........coooeiieiiiiiiii 29
UsiNg the Papertray ......coooeeeieiiee e 29

Using the manual BYPasS ... 29
Selecting an outPUL IOCALTION ........cuvviiiiiiieei e 30
Front OULPUL TrAY ....ooveieiiiii et e e e e e eeenes 30

Contents

3



Rear OULPUL SIOL ..ooeeieeeieec 30

Chapter 4: Printing ..ot eeeeeees 31
Printing @ dOCUMENT ......coiiiiiii e e 31
ACCeSSING PNt PrOPEItIES .....cvevieiiieiiieiiieiie ettt 32

USING YOUE PrOGIAIM ..ocoiieiieeieeee e s 32
Using the Printers folder ... 32
Understanding the print Settings ... 33
Saving favorite print SEtNGS ....ccoevvviiiiiiiii 33
Changing the direction information is printed on a page ...........ccccevveees 34
Changing the Paper SIZE .......oevvvviiiiiiiie e, 34
Printing multiple pages on one sheet of paper ...........ccoooeeeeiiiiceiccinnnns 35
Scaling @ dOCUMENT ...uuiiii e e et e e e e e eeeees 35
Fitting your document to a selected paper size ............cccceee e e e, 36
USING WAtEIMArKS ....ocooiieiieeieee s 36
USING OVEITAYS ... e et s e e e e e e e e ee it eeeaeeeeennnns 38
Printing on both sides of the paper ..............co oo, 40
Accessing the printer driver HElp ... 41
Canceling a print Job ... 41
Using the operator panel ... 41
Using the printer driVEE .......ooco it e e e eeaens 41

Chapter 5: COPYING cooiiieiieeieie e e e e e aaaaanns 42
Using the scanning bed..........ccooiiiiiiiiiii e ae e 42
USING the ADF ... i bbb e ee e rerereeaeeees 44
CUStOMIZING SEHINGS ..ooe e 45

DArkNESS ..o 45
L7001 (=T o | TP PP PRRPPPPPRPPPTN 45
NUMDET e 46
S Yo% | PSP 46
FaN0 172 1 o7 =T o [ OO PRUPP S PPPPPRP 47
Customizing default SEtHNQGS ......c.cvuviiiiii i e 48
Setting the TIMEOUL OPLION ......cooiiieiicie e e e e e e e 48
Creating tWO-Sided COPIES ...t i iieiieeeiie et e e e e e e e e e eeeeaeees 49
USING the ADF ...t et e e e e et e e e e e e eeneens 49
Using the scanning bed ... 49

Chapter 6: SCANNING ....ccooviiiiiiie e e e e eaannns 50

Scanning a document OF IMAJE.........ccceeveiieee e, 50
Contents

4



Chapter 7: FaXiNg ...oooii oo eeanees 51

Sending a fax automatically .............uiiiiiiii i e 51
Using the scanning bed ... e 51
USING the ADF ... e e e e et e e e e e eaneens 52

Sending afaxmanually............ccccoooiii i, 52
Using the scanning bed ... 52
USING the ADF ...t e e et e e e e e e eaneens 53

Receiving a fax automatically............ccccoiiiiiiiiiiiiive e 53

Receiving a fax manually ............ccooooiiiiiiiiiii 53

CUStOMIZING SEHINGS ..coeeiiieieeee e 54

Using Special fEatUreS ........ccoieei i nrennnees 56
Phonebook ... 56
BrOAACASE ... 58
DElay SENA ......o o eaan 58

Clearing display MeSSAQES .......coeeeeiiiie i 60

Chapter 8: REPOIMS . .iii i eeeaaaans 61
Chapter 9: MainteNaNCe..........uuiiiiiiiiiiiiiiiiie e 62

Cleaning the MAaChINE.........ccciii i e e e e e eeaeees 62
Cleaning the outside of the machinge ..........ccccccoeieiiiiiiiiiiiie e, 62
Cleaning the inside of the machine ..........ccccooiiiiiii i, 63
Cleaning the SCan UNIt .......c.oevviiiiiiiiiiiiie e, 64

Maintaining the toner cartridge..........oovuiiiiii e 64
Redistributing tONEI ........uciiii e e eeeens 65
Ordering toner Cartridges ...oouuuiiiiiiii e e e e e e e e e eeerrraaa 65
Replacing the toner cartridge ... 66
Cleaning the photoconductor drum .............iiiiiiiiii e, 68

Chapter 10: Troubleshooting........cccoevviiiiiiieeiie e, 69

Preventing document and Paper JamMS...........uuuuuuuuuuermmemmneeeneereneeeeeeeeeeeneeeeees 69

Clearing dOCUMENT JAMS......uii i ieieeeeiiiiee e e e e eeeee e e e e e e e e et e e e e e e eeeerenes 70
ADF MISTEEA ... 70
OULPUL MISTEEA ..vvveiiiiiiiiieeeeeeee e 72
Roller misfeed ......ooooiiiii s 72

Clearing Paper JAMS ......ccov e —— 73
Paper feed area (PAPER JAM Q) ..o 73
Paper exitarea (PAPER JAM 1) ... 75
Fuser and toner cartridge areas (PAPER JAM 2) ........ccccciiiiieviieeeecenennn, 77

Contents

5



Manual bypass area (BYPASS JAN) ...coooooiiiiiiiiii e 78

Clearing display MeSSAQES ....ccoeeeiieiee e 79
SOIVING ProbIEmMS. ... 79
Paper feeding problems ... 80
Printing and copying problems ... 81
SYox= Tl a1 aTo [ o] o] o] =1 14 < TSRS 84
Faxing problems ... 84
Print quality problems ... 86
Calling fOr SEIVICE.....cco e 89
N0 ) (T o =P 90
Safety information ... ——— 90
(070]01775T 1 0] 4 1S PP PRUPTTPPTPTPPPT 90
LASEI NMOLICES ...eeiieeeiiiiiiee ettt ettt e e e e e e e st eeeeeeeeaa 91
Electronic @miSSIiON NOLICES .......cc.uuiiiiiiiee ittt 91
TelecommUNICALIONS NOTICES ......uuviiiieee ettt 94
Contents

6



The Lexmark X215™ MFP is a multifunction printer. You can use it to copy, fax, print, and scan.

Before unpacking your machine, select a level, stable surface on which to set it. Allow adequate
space for air circulation and opening covers and trays. The area should be well-ventilated and away
from direct sunlight or sources of heat, cold, and humidity. Do not set the machine close to the edge
of your desk or table.

Clearance space

Front |482.6 mm (19 in.) - space to remove the paper
tray.

Back | 100 mm (4 in.) - space for ventilation.
Right | 100 mm (4 in.)

Left 100 mm (4 in.) - space for ventilation.

Getting started
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Understanding the parts

Front view
Document guide
Automatic document ADF release knob
feeder (ADF)
Document input tray
Operator
panel
Scanning bed
Document output tray
Document cover
Front output tray
Front cover
Paper tray
Paper output extension
Manual bypass
Rear view

Telephone
line connector

Rear cover
Power switch

AC power
cord

connector USB connector

Parallel connector

Understanding the parts
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Unpacking

1 Remove the machine and all accessories from the box. Make sure you have the following
items:

AC power cord

Lexmark X215 Setup
sheet

Telephone line cord\

Drivers and

/Documentation CD

Language overlays

Toner cartridge \

Note: The Drivers and Documentation CD contains the driver software, the User’s Guide
and the Adobe Acrobat Reader program.

2 Remove all tape from the machine.

Unpacking
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3 Apply the appropriate language overlays, if your language is not already displayed on the
operator panel.

LN

.

Unpacking
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Installing the toner cartridge

1 Open the front cover.

2 Remove the toner cartridge.

Installing the toner cartridge
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3 Gently shake the cartridge to distribute the toner.

Note: Thoroughly shaking the cartridge will assure the maximum copies per cartridge.

4 Insert the toner cartridge until it locks into place.

5 Close the front cover.

Installing the toner cartridge
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Connecting the cables

1 Connect the supplied telephone cord to the line jack and the other end to the wall jack.

2 Connect either a parallel (IEEE-1284 compliant) or USB cable to the printer port and the
other end to your computer.

Note: If any new hardware screens appear on your computer as a result of connecting
with the USB cable, click Cancel and proceed with setup.

Connecting the cables
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Powering on the machine

1 Plug one end of the supplied three-pronged electrical cord into the AC socket on the machine
and the other end into a properly grounded electrical outlet.

2 Turn on the power switch.

The message Varmi ng Up Pl ease Wit appears on the display.

Powering on the machine
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Understanding the operator panel

Darkness

Content

w
N

©Jclelc)

®OG0O
PEEOT

Content Selects the output type for the current copy job. Select from Text,
Mixed, or Photo quality.

Darkness | Adjusts the brightness of the current copy job to the selected value.

Number Selects the number of copies that you want to make.

Scale Adjusts the size of content on the page.

Advanced | Accesses special copy features such as Collate, 2-Up, and 4-Up.

Resolution | Adjusts the resolution of a faxed document.

Phonebook | Accesses and stores fax numbers as shortcuts and groups.

Redial/ Redials the most recently used fax number. Also used to enter

Pause programmed delays when entering shortcuts.

Telephone | Starts a dial tone (used to send a fax manually).

icon

Display Displays the current status and prompts during an operation.

Toner Low | Turns on when the toner cartridge you are using is near empty.

indicator

Numeric Used to enter a menu number, to dial a fax number, or to enter

keypad alphanumeric characters.

Stop/Clear | Stops an operation at any time.

Menu Enters menu functions and scrolls through menu items.

Scroll Scrolls through the options available for the selected menu item.

buttons

Select Confirms the selection on the display.

Return Sends you back to the previous menu level or exits the menu.

Start Starts a job.

Understanding the operator panel
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Setting the date and time

When you turn your machine on, the display prompts you to enter the correct date and time.

To set the date and time:

1 Use the numeric keypad to enter the two-digit month and day, and the four-digit year. For
example, 01-23-2003.

2 Enter the current time. The default clock setting is 12-hour.

3 Press the asterisk (*) to select AMor PM and then press Select.

Note: If the machine is unplugged for longer than 15 minutes, or turned off for longer than
an hour, when the power is turned back on, the machine prompts you to reset the
correct date and time.

Changing the display language
To change the language on the operator panel display:

1 Press Menu.

2 Press a scroll button (<0r») until MVACH NE SETUP appears on the top line of the display, and
then press Select.

3 Press a scroll button until Language appears on the bottom line of the display, and then press
Select.

The current language setting appears on the bottom line of the display.

4 Press a scroll button until you see the language you want on the display, and then press
Select.

5 To return to the Ready prompt, press Stop/Clear.

Setting the date and time
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Setting the country

It is important to select your country or, if your country is not listed, the country closest to you. This
information ensures that the fax modem on your machine can work at the optimal setting for the
regional telephone system.

To set your country:

1
2

Press Menu.

Press a scroll button (< 0r») until MACH NE SETUP appears on the top line of the display, and
then press Select.

Press a scroll button until Count ry appears on the bottom line of the display, and then press
Select.

Press a scroll button until you see the country you want on the display, and then press Select.

To return to the Ready prompt, press Stop/Clear.

Setting the station ID

To set the station ID:

1
2

Press Menu.

Press a scroll button (< 0r») until FAX SETUP appears on the top line of the display, and
then press Select.

Press a scroll button until St ati on | Dappears on the bottom line of the display, and then
press Select.

Enter your fax number using the numeric keypad, and then press Select.

Enter an ID name to identify the fax device using the alphanumeric feature of the numeric
keypad, and then press Select.

To use the alphanumeric feature of the numeric keypad, press the number key that
corresponds to the character that you want to use one or more times until the correct letter is
displayed (for example, press the number 2 three times to enter the letter C). Then, press the
right scroll button to move the cursor to the next space. Repeat until the name is entered.

Note: You can also enter special characters (+ - , . * [/ * # &) by pressing the 0
(zero) key.

To return to the Ready prompt, press Stop/Clear.

Setting the country
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Setting the Power Saver mode

Power Saver mode reduces power consumption when the machine is not in use.

To select the amount of time that the machine waits after each job before it switches to Power Saver
mode:

1 Press Menu.

2 Press a scroll button (<0or») until MACH NE SETUP appears on the top line of the display,
and then press Select.

3 Press a scroll button until Power Saver appears on the bottom line of the display, and then
press Select.

4 Press a scroll button until the setting you want (On or O f ) appears on the display, and then
press Select.

Note: Selecting Off disables Power Saver mode.

5 If you select Off in step 4, go to step 6 now.

If you select On in step 4, press a scroll button to display the time setting you want (5, 10, 15,
30, or 45 minutes), and then press Select.

6 To return to the Ready prompt, press Stop/Clear.

Setting the Power Saver mode
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Installing software
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After setting up your machine and connecting it to your computer, you must install the drivers. The
drivers are available on the CD packaged with your machine. The CD contains the following:

« Drivers for printing, scanning (TWAIN), and USB support
* User's Guide
* Adobe Acrobat Reader

Installing the drivers

1 Close all unnecessary programs.
2 Launch the Drivers and Documentation CD.
3 Follow the instructions on the screen.
a Select the language that you want to use in the installation window.
b Click Install.
¢ Click Continue Anyway if any messages about certification appear.
Your product has been thoroughly tested and is compatible with Windows.
d When you receive the message that installation is complete, remove the CD.

e Make sure that the radio button labeled Yes, | want to restart my computer now is
selected.

f  Click Finish.

g Ifany Lexmark X215 new hardware screens appear, click Next or Continue until finished.

Installing software
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Removing the drivers

You should remove the drivers if you are upgrading the software or if your driver installation fails. You
can remove the software using the CD or the Windows unlinstallShield.

Note: Before removing, close all programs. You must restart your computer after
removing the drivers.

1 Click Start » Programs » Lexmark X215.
2 You can select each driver individually to remove.

* To remove the scan driver, select TWAIN Driver Uninstall.

* To remove the printer driver, select Printer Driver Uninstall. When the Lexmark X215
Series Driver Maintenance window appears, check Remove, and then click Next.

3 When your computer prompts you to confirm your selection, click Yes.
The selected driver, and all of its components, are removed from your computer.
4 Click OK.

Restart your computer.

Removing the drivers
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9 Loading paper and changing paper size
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Selecting print materials

Select print materials that are an appropriate size for your input source (paper tray or manual
bypass). Using print materials that are not recommended may cause paper jams or poor print quality.

Size, input sources and capacities

Input source/capacity?’

Size (mm/in.) Paper tray Manual bypass

Plain paper Yes/250 Yes/1
Letter (215.9 x 279/8.5 x 11)

A4 (210 x 297/8.27 x 11.69)

Folio (215.9 x 330.2/8.5 x 13)

Legal (215.9 x 355.6/8.5 x 14)
Executive (184.2 x 266.7/7.25 x 10.5)
B5 (182 x 257/7.2 x 10)

A5 (148 x 210/5.83 x 8.27) No/0 Yes/1
A6 (105 x 148/4.13 x 5.88)
Envelopes2 No/0 Yes/1

No. 9 (98.4 x 225.4/3.88 x 8.88)
No. 10 (104.8 x 241.3/4.12 x 9.5)
DL (110 x 220/4.33 x 8.66)

C5 (162 x 229/6.38 x 9.02)

C6 (114 x 162/4.49 x 6.38)

B5 (176 x 250/6.93 x 9.84)

No. 7 3/4 (98.4 x 190.4/3.88 x 5.83)

Labels? No/0 Yes/1

Letter (215.9 x 279/8.5 x 11)
A4 (210 x 297/8.27 x 11.69)

Transparency films? No/0 Yes/1
Letter (215.9 x 279/8.5 x 11)
A4 (210 x 297/8.27 x 11.69)

Loading paper and changing paper size
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Size, input sources and capacities

Input source/capacity?’

Size (mm/in.) Paper tray Manual bypass

Card stock? No/0 Yes/1

A6 card (105 x 148/4.13 x 5.88)

Postcard (101.6 x 152.4/4 x 6)

1 Maximum capacity may be reduced depending on paper thickness.
2 This media must be fed one sheet at a time through the manual bypass.

Guidelines for paper and specialty media

When selecting or loading paper, envelopes, transparencies, or other specialty media, keep these
guidelines in mind:

Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and poor
print quality.

Use only high quality, copier grade paper. Avoid paper with embossed lettering, perforations,
or texture that is too smooth or too rough.

Store paper in its ream wrapper until ready to use. Place cartons on pallets or shelves, not on
the floor. Do not place heavy objects on top of the paper, whether it is packaged or loose.
Keep it away from moisture, or other conditions that could cause it to wrinkle or curl.

During storage, you should use moisture-proof wrap, such as a plastic container or bag, to
prevent dust and moisture from contaminating your paper.

Always use paper and other materials that conform with those listed in “Selecting print
materials” on page 21.

Use only well-constructed envelopes with sharp, well creased folds.
Do not use envelopes with clasps and snaps.

Do not use envelopes with windows, coated lining, self-adhesive seals, or other synthetic
materials.

Do not use damaged or poorly made envelopes.
Load specialty media one sheet at a time.
Use only materials recommended for use with laser printers.

To prevent specialty media, such as transparencies and label sheets, from sticking together,
remove each sheet from the output tray as it is printed.

Place transparencies on a flat surface after removing them from the machine.

Do not leave transparencies in the paper tray for long periods of time. Dust and dirt may
accumulate on the film, resulting in spotty printing.

To avoid smudging caused by fingerprints, handle transparencies and coated paper carefully.

Selecting print materials
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To avoid fading, do not expose the printed transparencies to prolonged sunlight.

Store unused materials at temperatures between 59° F and 86° F (15° C to 30°C). The
relative humidity should be between 10% and 70%.

The laser printing process heats paper to high temperatures of 180° C (356° F). Use only
paper able to withstand these temperatures without discoloring, bleeding, or releasing
hazardous emissions. Check with the manufacturer or vendor to determine whether the paper
you have chosen is acceptable for laser printers.

Verify that your label adhesive material can tolerate a fusing temperature of 180° C (356°F)
for 0.1 second.

Make sure there is no exposed adhesive material between labels. Exposed areas can cause
labels to peel off during printing, which can cause paper jams. Exposed adhesive can also
damage machine components.

Do not load a sheet of labels through the machine more than once. The adhesive backing is
designed for only one pass through the machine.

Do not use labels that are separating from the backing sheet or are wrinkled, bubbled, or
otherwise damaged.

Selecting print materials
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Loading the paper tray

The paper tray can hold a maximum of 250 sheets of 20 Ib plain paper. For copying or faxing, use A4,

letter, or legal size paper only. For printing, use any supported paper size. The paper tray is preset to
use letter size paper. To load a larger size paper, you must adjust the guides.

To load the paper tray:

1 Pull open the paper tray and push down the pressure plate until it locks in position.

To load longer paper, such as legal size paper, extend the rear paper guide to lengthen the
tray.

Loading the paper tray
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Holding the tray on a stable surface, press the guide lock and slide the rear guide until it locks at the
paper length you want.

2 Prepare a stack of paper for loading by flexing or fanning it back and forth. Straighten the
edges on a level surface.

Loading the paper tray
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3 Load the paper with the print side facing down and the short edges of the paper placed at the
front and rear of the tray.

Note: Load letterhead paper with the design side facing down. The top, short edge of the
sheet with the logo should be placed at the front of the tray.

4 Make sure the paper is below the triangle on the left inside wall of the tray.

Note: Paper overloading may cause paper jams.

triangle

Loading the paper tray
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5 Squeezing the paper guides as shown, move the guides until they lightly touch the side of the
stack of paper.

Note: Do not push the paper guides far enough to cause the materials to warp. Incorrect
adjustments may cause paper jams.

6 Close the paper tray.

Note: The paper level indicator, on the front of the paper tray, shows the amount of paper
currently in the tray. When the indicator lowers, the tray is empty.

Paper full

7 Set the correct paper type and size using the operator panel buttons. For help, see “Setting
the paper type and size” on page 29.

Note: If you experience problems with the paper feed, place the paper in the manual
bypass.

Loading the paper tray
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Loading the manual bypass

The manual bypass is located at the front of your machine.

Use the manual bypass to print transparencies, labels, envelopes or postcards. Make sure that the
specialty media is flat and free of any curls.

You may also use the manual bypass to make quick runs of paper types or sizes that are not
currently loaded in the paper tray.

For information on acceptable print media to use in the manual bypass, see “Selecting print
materials” on page 21. Using only the specified print media helps prevent paper jams and print
quality problems.

To load the manual bypass:

1 Place a sheet of the selected print media, print side facing up, into the center of the manual
bypass, and adjust the paper guides to the paper’s width.

The machine automatically engages the print media.

Note:

« Hold transparencies by the edges and avoid touching the print side. Oils from
your fingers that are deposited on the transparency can effect print quality.

* Insert envelopes with the flap side face down and with the stamp area on the
top left side.

« If you experience problems with paper feed, turn the paper around.

Loading the manual bypass
28



Setting the paper type and size

After loading paper in the paper tray or manual bypass, set the paper type and size using the
operator panel buttons. The settings apply when copying only. When printing, select the paper type
and size in the program you are using.

Using the paper tray

To set the paper type and size for the paper tray:

1
2

Press Menu.

Press a scroll button (<0r») until PAPER MENU appears on the top line of the display, and
then press Select.

Press a scroll button until Tray Type appears on the bottom line of the display, and then
press Select.

Press a scroll button to select the paper type you want to use, and then press Select.

Press a scroll button until Tray Si ze appears on the bottom line of the display, and then
press Select.

Press a scroll button to select the paper size you are using, and press Select.

To return to the Ready prompt, press Stop/Clear.

Using the manual bypass

To set the paper type and size for the manual bypass:

1
2

Press Menu.

Press a scroll button (<0r») until PAPER MENU appears on the top line of the display, and
then press Select.

Press a scroll button until Bypass Type appears on the bottom line of the display, and then
press Select.

Press a scroll button to select the paper type you want to use, and then press Select.

Press a scroll button until Bypass Si ze appears on the bottom line of the display, and then
press Select.

Press a scroll button to select the paper size you want to use, and then press Select.

To return to the Ready prompt, press Stop/Clear.

Setting the paper type and size
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Selecting an output location

The machine has two output locations; the front output tray and the rear output slot.

Front output
tray

Front output tray

The front output tray should be used to output plain paper only. You should use the rear output slot
for envelopes, labels, small custom-sized paper, postcards, and transparencies. To use the front
output tray, make sure the rear cover is closed.

Paper is output facedown into the front output tray, with the last page on the bottom. This tray should
be used for most jobs and is recommended for jobs requiring over 50 sheets of plain paper
continuously.

Note: If problems, such as excessive curl, occur when using the front output tray, try using
the rear output slot.

Rear output slot

You can use the rear output slot for all paper types, however, for envelopes, labels, small
custom-sized paper, postcards, and transparencies using this slot is recommended. To use the rear
output slot, open the rear cover.

Paper is output faceup through the rear output slot, with the last page on the top. To avoid paper
jams, do not open or close the rear cover while printing.

CAUTION: The fuser area is hot. Avoid contact with the fuser area to prevent burns.

Selecting an output location
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a Printing
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Printing a document

To print a job from a typical Windows program:

1 Open the document you want to print.
2 Click File » Print.

The Print window appears.

Verify the correct printer (Lexmark X215) is selected in the Print window.

4 Modify the print settings as appropriate (for example, the pages you want to print or the
number of copies).

Note: Click Properties to adjust advanced print settings not available from the first
window (for example, orientation, paper source, size, and type). If the Properties
button does not appear in the Print window, click Options, Printer, or Setup
(depending on the program) first, and then click Properties in the next window.

5 Click OK or Print.
Note:

* Some Windows programs will override settings you specify in Print Properties
(for example, if the number of copies specified in your program’s Print window
is 1, and you change this setting to 3 in the Print Properties window, the
program may still print only 1 copy). Therefore, change all print settings
available in the program first, and then change any remaining settings in Print
Properties.

« The settings you change remain in effect only while you are using the current
program. To make your changes permanent, access Print Properties using the
Printers folder. For help, see “Accessing Print Properties” on page 32.
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Accessing Print Properties
The print properties are where you specify print settings. Some of the settings you might want to
adjust for a print job include:

* Orientation - The direction information is printed on a page. (See page 34.)
e 2-UP or 4-UP - Multiple pages printed on one sheet. (See page 35.)

e Scale - The size information is printed on a page. (See page 35.)

« Fitto Page - Used to fit a document to a selected paper size. (See page 36.)
* Watermark - Text printed over an existing document. (See page 36.)

» Overlay - Specific text or images printed on multiple documents, such as the text or images
that make up a letterhead. (See page 38.)

e Odd/Even pages and Manual feed - Used to print on both sides of the paper. (See page 40.)

You can access Print Properties using your program or using the Printers folder.

Using your program

When you access Print Properties from your program, any settings you change are in effect only
while you are using the current program.

1 Click File » Print.

The Print window appears.
2 \Verify the correct printer (Lexmark X215) is selected in the Print window.
3 Click Properties.

If the Properties button does not appear in the Print window, click Options, Printer, or Setup
(depending on the program) first, and then click Properties in the next window.

Using the Printers folder

When you access Print Properties from the Printers folder, any settings you change are permanent.

To access Print Properties from the Printers folder follow the instructions for your operating system:

Windows 98/Me and Windows
NT 4.0

Windows 2000

Windows XP

1 Click Start » Settings » 1 Click Start » Settings » 1 Click Start » Printers and
Printers. Printers. faxes.

2 Right-click the Lexmark X215 2 Right-click the Lexmark X215 2 Right-click the Lexmark X215
printer icon. printer icon. printer icon.

3 Click Properties. 3 Click Printing Preferences. 3 Click Document Default.

4 Change the settings on each tab
as appropriate and then click

4 Change the settings on each tab
as appropriate and then click

Change the settings on each tab
as appropriate and then click
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Understanding the print settings

All of the print settings are on the four main tabs of Print Properties: the Layout tab, Paper tab,
Graphics tab, and Extras tab.

From this tab: You can change these settings:

Layout Orientation - Select how you want the document oriented on the printed page.
Layout - Select the type of layout you want your document to have.

Paper Copies - Select the number of copies you want to print.
Type - Select the type of paper you are using.

Make sure that Type is set to Printer Default. If you load specialty media, select
the corresponding paper type. For more information see page 29.

Source - Select the paper input source (front input tray or manual bypass).

The Manual Feed source is used when printing specialty media. You have to load
one sheet at a time into the manual bypass.

If the paper source is set to Auto Select, the machine automatically picks up print
materials from the manual bypass first, and then the paper tray.

Size - Select the size of the paper you are using.

Graphics Resolution - Select the quality of the output (600 dots per inch (dpi) for normal
quality or 300 dpi for draft quality).

Extras Watermark - Select the text you want to print over an existing document.

Overlay- Select a one-page document containing text or graphics to print over
another document.

Saving favorite print settings

You can save your favorite print settings using the Favorites option, which is located on each
Properties tab of the printer driver.

To save a favorite print setting:

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

2 Modify the print settings you want to save on the first tab (for example, under Layout Options
you might set Type to Reduce/Enlarge and Percentage to 50%).

3 Enter a name in the Favorites list (for example, if you made the Layout Options changes
above, you might name this setting Half-scale).

4 Click Save.
5 Repeat steps 2 through 4 for each tab you want to specify a Favorites setting.

To use a saved setting, select the name entered in step 3 from the Favorites drop-down list. To delete
a saved setting, select it from the Favorites drop-down list and click Delete. To restore the printer
driver default setting, select <Printer Defaults> from the Favorites drop-down list.
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Changing the direction information is printed on a page

You can select to rotate the information 180 degrees, or print the information in a portrait or
landscape orientation. Portrait prints across the width of the page, and landscape prints across the
length of the page.

Landscape Portrait

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

Note: Remember, if you can change this setting from the Print window of your program,
you do not need to access Printer Properties unless you want to make this a
permanent change (in effect for every document you print).

2 From the Paper tab, select Portrait or Landscape.
If you want to rotate the information, select 180 from the drop-down menu.

4 Click OK.

Changing the paper size
You can specify the size of paper loaded in the output tray using the size option on the Paper tab.

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

Note: Remember, if you can change this setting from the Print window of your program,
you do not need to access Printer Properties unless you want to make this a
permanent change (in effect for every document you print).

2 From the Paper tab, select the size you want from the Size drop-down menu.

Note: If the size you want is not listed, click Add Custom. Add your custom paper size,
and then click Select. You can now select it from the Size drop-down menu.

3 Click OK.
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Printing multiple pages on one sheet of paper

You can select the number of pages to print on a single sheet of paper. To print more than one page
per sheet, the pages will appear decreased in size and arranged on the sheet. You can print up to 4
pages on one sheet.

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

2 From the Layout tab, choose either 2-UP or 4-UP in the Type drop-down list.
Select the page order in the Page Order drop-down list, if necessary.

4 Click OK.

Scaling a document

You can change the scale of your print job on a page.

@

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

Note: Remember, if you can change this setting from the Print window of your program,
you do not need to access Printer Properties unless you want to make this a
permanent change (in effect for every document you print).

2 From the Layout tab, select Scale in the Type drop-down list.
Enter a scaling rate in the Percentage box.

4 Click OK.
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Fitting your document to a selected paper size

You can scale your print job to any selected paper size regardless of the digital document size. This
can be useful when you want to check fine details on a small document.

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

Note: Remember, if you can change this setting from the Print window of your program,
you do not need to access Printer Properties unless you want to make this a
permanent change (in effect for every document you print).

2 From the Layout tab, select Fit to Page in the Type drop-down list.
Select the correct size from the Target Paper drop-down list.

4 Click OK.

Using watermarks

You can print text over an existing document using the Watermark option. For example, you can have
the words “DRAFT” or “CONFIDENTIAL" printed diagonally across the first page or all pages of a
document.

There are several predefined watermarks that come with your machine. You can modify these
predefined watermarks or create new ones.

Using an existing watermark

1 Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

2 From the Extras tab, select the watermark you want from the Watermark drop-down list.
The selected watermark appears in the preview image.
3 Click OK.
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Creating a watermark

1

5
6

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, click Edit in the Watermark section.
The Edit Watermarks window appears.
Enter your text message in the Watermark Message box.
Select the watermark options you want.

You can select to print on the first page only, specify font attributes, or set the angle of the
watermark.

Click Add to add the new watermark to the list.

Click OK.

To stop printing the watermark, select No Watermark from the Watermark drop-down list.

Editing a watermark

1

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, click Edit in the Watermark section.
The Edit Watermarks window appears.

Select the watermark you want to edit in the Current Watermarks list, and then make your
changes.

Click Update.
Click OK.

Deleting a watermark

1

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, click Edit in the Watermark section.
The Edit Watermarks window appears.

Select the watermark you want to delete in the Current Watermarks list, and then click
Delete.

Click OK.
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Using overlays

An overlay is text or images in a special file format that can be printed on any document. Overlays
are often used to take the place of preprinted forms and letterhead. Instead of using preprinted
letterhead, you can create an overlay containing the same information that is currently on your
letterhead. Then, to print a document with your company'’s letterhead, you can select to print the
letterhead overlay on your document. This eliminates the need to load special paper in the machine.

Creating an overlay

You can create a new page overlay containing your logo or image.

1

Create or open a document containing text or an image you want to use in a new page
overlay.

Position the items exactly as you want them to appear when printed as an overlay, and then
save the file.

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, click Edit in the Overlay section.
The Edit Overlays window appears.

Click Create Overlay.

The Create Overlay window appeatrs.

Enter a name, up to eight characters, in the File Name box. Specify where you want to save
the file. (The default is C:\Formover.)

Click Save.

The name appears in the Overlay List box.
Click OK or Yes.

Note:

e This file does not print. It is stored on your computer until you are ready to use
it to overlay a document.

« The overlay document size must be the same as the document it overlays.
< Do not create an overlay with a watermark.

Accessing Print Properties
38



Using an overlay

After you create an overlay, you can use it to print with your document. To print an overlay with a
document:

1
2

Create or open the document you want to print.

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, select the overlay you want from the Overlay drop-down list.
If the overlay file you want does not appear in the Overlay drop-down list:

a Click Edit.

b Click Load Overlay.

¢ Select the overlay file you want.

If you stored the overlay file you want to use into an external source, you can also load the
file when you access the Load Overlay window.

d Click Open.

The file now appears in the Overlay List box.
e Select the overlay.
f Click OK.

If you want a confirmation message to appear each time you send a document to print, select
Confirm Page Overlay When Printing.

Answering Yes to the message means that the selected overlay will be printed with your
document. Answering No to the message cancels overlay printing.

If this box is empty and an overlay has been selected, the overlay will automatically be printed
with your document.

Click OK or Yes.

Note: The overlay document resolution must be the same as the document it overlays.

Deleting an overlay

1

a b~ W DN

Access Print Properties either from your program or from the Printers folder. For help, see
page 32.

From the Extras tab, click Edit in the Overlay section.

Select the overlay you want to delete from the Overlay List box.
Click Delete Overlay.

Click OK.
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Printing on both sides of the paper

You can print on both sides of the paper using the manual bypass to feed previously printed pages
back into your machine.

1

2
3
4

10

11

12
13

14
15

Open the document you want to print.

Click File » Print.

Verify the correct printer (Lexmark X215) is selected in the Print window.
Click Properties.

If the Properties button does not appear in the Print window, click Options, Printer, or Setup
(depending on the program) first, and then click Properties in the next window.

From the Extras tab, select Print Odd Pages from the Print Order list box.

Note: Remember, if this setting is available in the Print window of your program, the
setting there may override your selection here (in Print Properties) and create
undesirable output. If you prefer to customize your settings using Print Properties,
clear the settings in the Print window of your program first.

Click OK.

Remove the printed pages from the front output tray.

Click File » Print.

The Print window appears.

Verify the correct printer (Lexmark X215) is selected in the Print window.
Click Properties.

If the Properties button does not appear in the Print window, click Options, Printer, or Setup
(depending on the program) first, and then click Properties in the next window.

From the Extras tab, select Print Even Pages from the Print Order list box.

Note: Remember, if this setting is available in the Print window of your program, the
setting there may override your selection here (in Print Properties) and create
undesirable output. If you prefer to customize your settings using Print Properties,
clear the settings in the Print window of your program first.

From the Paper tab, select Manual Feed from the Source list box.

Load the first printed page into the manual bypass with the previously printed side facedown,
and with the top of the page feeding into the machine first.

Click OK.

Continue feeding the previously printed pages into the manual bypass in the order that they
were originally printed until printing is complete.
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Accessing the printer driver Help

The printer driver Help gives detailed information about various printing features.
To access the Help:
1 Open the document you want to print.
2 Click File » Print.
The Print window appears.
3 Verify the correct printer (Lexmark X215) is selected in the Print window.

4 Click Properties to open the Properties window.

Note: If the Properties button does not appear in the Print window, click Options, Printer,
or Setup (depending on the program) first, and then click Properties on the next
screen.

5 Click Help on any of the Properties tabs.

Canceling a print job

There are two ways to cancel a print job:

* Using the operator panel.
e Using the printer driver.

Using the operator panel

To cancel a print job using the operator panel, press Stop/Clear.

The machine prints the page currently in progress and deletes the rest of the print job.

Note: Pressing Stop/Clear cancels only the current job. If more than one print job is in the
print queue, press Stop/Clear once for each job.

Using the printer driver

To cancel a print job using the printer driver:

1 Click Start » Settings » Printers.
2 Double-click the Lexmark X215 printer icon.

3 From the Document menu, select Cancel Printing (Windows 98/Me) or Cancel
(Windows NT 4.0, Windows 2000, Windows XP).

Accessing the printer driver Help
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9 Copying

\V -

Using the scanning bed

1 Make sure paper is in the tray.
If you need to load paper, see “Loading the paper tray” on page 24.

2 Open the document cover.

Note: If you are copying a page from a book or magazine, lift the cover until its hinges are
caught by the stopper.

Copying
42



3 Place the document facedown on the glass and align it with the registration guide on the left
top corner.

Note: Make sure that no other documents are in the automatic document feeder (ADF).
If a document is detected in the ADF, that document is copied before the document
on the glass.

4 Close the document cover.

Note: If you are copying a book or magazine that is thicker than 30 mm, leave the
document cover open.

5 If you are only making one copy, go to step 6 now.

If you are making multiple copies, press Number on the operator panel and use the numeric
keypad to enter the number of copies.

Note: You must press Number before entering the number of copies that you want to
make. If you do not, the machine identifies any numbers you enter directly on the
numeric keypad as a fax number and attempts to fax your document.

6 Customize any copy settings you want to change. For help, see page 45.

7 Press Start.
Note:

* Leaving the cover open while copying may affect the copy quality and toner
consumption.

» Press Stop/Clear to cancel a copy job in progress.

« Clean the document glass regularly. Dust on the document glass may affect
print quality.

Using the scanning bed
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Using the ADF

You can copy up to 30 documents (20 Ib, 75 g/m?) using the ADF.
When you use the ADF:

e Do not load documents smaller than 142 x 148 mm (5.5 x 5.83 in.) or larger than 216 x 356
mm (8.5 x 14 in.).

* Do not attempt to feed the following types of documents:
— Carbon-paper or carbon-backed paper
— Coated paper
— Onion skin or thin paper
— Wrinkled, creased, curled, rolled, or torn paper
* Remove all staples and paper clips before loading documents.

« Make sure any glue, ink, or correction fluid on the paper is completely dry before loading
documents.

* Do not load documents containing different sizes or weights of paper.

If you want to make copies from booklets, pamphlets, transparencies, or documents with other
unusual characteristics, use the scanning bed. For help, see page 42.

1 Load the document (up to 30 pages) faceup into the ADF and adjust the document guides to
the document size.

Note: Letter and A4 sized paper should align to the corresponding registration marks on
the paper guide. Legal-sized paper extends beyond the edge of the guide.

2 Customize any copy settings you want to change. For help, see page 45.

Using the ADF
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3 Press Start to begin copying.
Note:

» Press Stop/Clear to cancel a copy job in progress.
« Clean the document glass regularly. Dust on the document glass may affect
print quality.

Customizing settings

You can temporarily modify all the copy options (darkness, content, number, scale, and advanced)
using the operator panel buttons. Settings remain in effect until a predefined Timeout period is
expired. To change the Timeout period, see page 48. To make your selections permanent, see
“Customizing default settings” on page 48.

Note:
* Make all of your selections before pressing Start.
« Pressing Stop/Clear while modifying the copy settings cancels all settings for
the current job and returns them to their default status.
Darkness

You can adjust the darkness for an original document containing paint markings or dark images.
Choose from the following darkness settings:

e Light: Works well with dark print.
* Normal: Works well with standard typed or printed documents.
» Dark: Works well with light print or faint pencil markings.

To adjust the darkness, press Darkness repeatedly.

Each time you press the button, the LED labeled with the selected mode lights up.

Content

This setting is used to improve the copy quality. Choose from the following content settings:

e Text: Use for documents containing mostly text.
» Mixed: Use for documents with mixed text and graphics.
* Photo: Use when the originals are photographs.

To select the content, press Content repeatedly.

Each time you press the button, the LED labeled with the selected mode lights up.

Note: When you copy a document with color in the background using the Mixed mode,
the machine automatically removes the background color. If you want to include
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the background color in your copy, load the document about 5 mm away from the
edges of the scanning bed, or change the darkness setting.

Number

To select the number of copies from 1 to 99:

1 Press Number.

2 Enter the number of copies you want to print using the numeric keypad, and then press
Select.

The selected number appears on the display.

Scale

If you copy original documents from the document glass, you can reduce or enlarge the size of a
copied image from 25% to 400%.

If you copy original documents from the ADF, you can reduce or enlarge the size of a copied image

from 25% to 100%.

@

To scale a document to a pre-defined copy size:

1 Press Scale.

The default setting appears on the bottom line of the display.

2 Press a scroll button (€ 0r») repeatedly until the copy size you want is displayed, and then
press Select.

To customize the copy size:

1 Press Scale.

2 Press a scroll button (<0r») until CUSTOM 25- 400%(or CUSTCM 25- 100%) appears on the
bottom line of the display, and then press Select.

3 Enter the size you want using the numeric keypad, and then press Select.

The selected number appears on the display.
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Advanced

Using the advanced option, you can copy images onto a page in a variety of layouts.

The advanced settings available when a document is loaded in the ADF include:

Off: Turns off the advanced copy features.

Collation: Controls the sequence in which multiple page documents are printed (for example,
if you copied a 5 page document without collation, the copier would output 5 pages of the first
page, 5 pages of the second page, and so on. If you selected collation, the copier would
output pages 1 through 5 for the first copy, pages 1 through 5 for the second copy, and so
on.)

2-UP: Prints two copied documents on a single page.

4-UP: Prints four copied documents on a single page.

==

o

.
I
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The Advanced settings available when a document is loaded on the scanner bed include:

Off: Turns off the advanced copy features.

Auto Fit: Automatically reduces or enlarges the original image so that the resulting copy will
fit on the paper that is currently loaded in the machine.

2-side: Prints two copied documents on a single page. After copying the first document, you
are prompted to place a second document on the scanner bed. This feature is very similar to
the 2-Up option which is available when using the ADF. However, when using the scanner
bed, the 2-Side feature is especially useful when copying both sides of an original document.

Note: Autofit and 2-side can be selected only when the paper size is letter, legal, or A4.

To select the advanced setting you want to use:

1 Press Advanced repeatedly.

2 When the setting you want appears, click Select.
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Customizing default settings

The default settings for the basic copy options (darkness, content, number, scale) are set using the
operator panel menu. When you copy a document, these default settings are used unless you
change them using the operator panel buttons (see page 45).

To customize the default settings:

Press Menu.

3 Press a scroll button (<4 0r») until COPY MENU appears on the top line of the display, and
then press Select.

4 Press a scroll button to scroll through the copy options.
When the option you want to change appears, press Select.

6 Change the setting by pressing a scroll button or enter a value using the numeric keypad,
and then press Select.

7 Repeat steps 4 through 6, as necessary.

Note: While setting copy options, pressing Stop/Clear cancels the changed setting and
restores the default status.

8 To return to the Ready prompt, press Stop/Clear.

Setting the Timeout option
If you change your copy settings using the operator panel buttons for a specific job, your machine will
eventually restore your default settings.

To set the length of time the machine waits before restoring default settings:

1 Press Menu.

2 Press a scroll button (<0r») until MVACH NE SETUP appears on the top line of the display, and
then press Select.

3 Press a scroll button until TI MEQUT appears on the bottom line of the display, and then press
Select.

4 Press a scroll button until the status you want (15, 30, 60, or 180 seconds) appears on the
display, and then press Select.

5 To return to the Ready prompt, press Stop/Clear.
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Creating two-sided copies

You can create two-sided copies by using the manual bypass to feed previously copied output pages
back into your machine.

Using the ADF

1

Copy the first side of your original document normally.

Note: Make sure to maintain a consistent orientation when loading documents into the
ADF. If you do not, the reverse side of the document copy could print upside down.

Reload your original document into the ADF with the opposite side facing up.

Load the previously copied output page into the manual bypass with the previously copied
side facedown, feeding the top edge of the page into the machine first.

Press Start.

Using the scanning bed

1

Place your original document on the scanning bed facedown, with the top left corner of the
page aligned with the arrow on the corner of the document glass.

Press Start.

Place the opposite side of your document on the scanning bed, with the top left corner of the
page aligned with the arrow on the corner of the document glass.

Load the previously copied output page into the manual bypass with the previously copied
side facedown, feeding the top edge of the page into the machine first.

Press Start.
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@ Scanning
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Scanning a document or image

Scanning with this machine requires the use of TWAIN-compliant software, such as Scansoft
PaperPort or Adobe Photoshop. The first time you use the scanning function, select your machine as
your TWAIN source in the program you want to use.

To scan a document or image:
1 Place the document or image on the document glass or in the ADF.
2 Open a program, such as PaperPort or Photoshop.

3 Refer to the user documentation for your program for instructions on acquiring an image and
other information.

Scanning
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0 Faxing
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There are two ways you can send or receive a fax:

 Automatic
Manual

You might select the Automatic mode when you know the receiving fax machine and your fax
machine are connected to a dedicated phone line (that is, the phone line is used only for faxing). If
the phone line is shared between a telephone and a fax machine, you might want to select the
Manual mode.

Sending a fax automatically

Using the scanning bed

1 Make sure there are no documents loaded in the ADF.

2 Place the first page of your document on the glass.

3 Customize any fax settings you want to change. For help, see page 54.
4

Using the numeric keypad, enter the number of the fax machine to which you want to send
your document.

Note: You may enter a number using shortcuts or groups. For help, see page 58.

5 Press Start.
The operator panel prompts you for another page.

6 Using the keypad, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
scanning the entire document.

Note: Pressing Stop/Clear cancels the faxing process.
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Using the ADF

Place your document into the ADF.
Customize any fax settings you want to change. For help, see page 54.

Using the numeric keypad, enter the number of the fax machine to which you want to send
your document.

Note: You may enter a number using shortcuts or groups. For help, see page 58.
Press Start.

Note: Pressing Stop/Clear cancels the faxing process.

Sending a fax manually

Because the Manual mode is often used when the phone line is shared between a telephone and the
fax machine, there may be times when the fax recipient mistakenly answers the telephone rather
than connecting the fax machine. If this happens, inform the recipient you are attempting to send a
fax, ask them to hang up the telephone, and then resend the fax. When you connect with the
receiving fax machine you should hear a high-pitched fax signal.

Using the scanning bed

1
2
3
4
5

Make sure there are no documents loaded in the ADF.

Place the first page of your document on the glass.

Customize any fax settings you want to change. For help, see page 54.

Press the telephone icon button to get a dial tone.

Using the numeric keypad, enter the number of the fax machine to which you want to send
your document.

Note: You may enter a number using shortcuts or groups. For help, see page 58.

When you hear a high-pitched fax signal, indicating a connection with the receiving fax
machine, press Start.

The operator panel prompts you for another page.

Using the keypad, press 1 (for yes) if you have more pages, or 2 (for no) if you have finished
scanning the entire document.

Note: Pressing Stop/Clear cancels the faxing process.

Sending a fax manually
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Using the ADF

Place your document into the ADF.
Customize any fax settings you want to change. For help, see page 54.

Press the telephone icon button to get a dial tone.

A W N

Using the numeric keypad, enter the number of the fax machine to which you want to send
your document.

Note: You may enter a number using shortcuts or groups. For help, see page 58.

5 When you hear a high-pitched fax signal, indicating a connection with the receiving fax
machine, press Start.

Note: Pressing Stop/Clear cancels the faxing process.

Receiving a fax automatically
Your machine is preset to receive faxes automatically. If you want to change the default setting to
manual, see “Receiving a fax manually” on page 53.

When the Receive Mode is set to Automatic, your machine answers an incoming fax on a specified
number of rings. Once the connection is established, the machine automatically receives the fax.

Note: To change the number of rings before the machine answers or to adjust the ringer
volume, see “Customizing settings” on page 54.

Receiving a fax manually

1 Select the Manual Receive Mode setting on the operator panel menu.

a Press Menu.

b Press a scroll button (€ 0r») until FAX SETUP appears on the top line of the display, and
then press Select.

¢ Press a scroll button until Recei ve Mode appears on the bottom line of the display, and
then press Select.

d Scroll to the Manual setting, and then press Select.

e To return to the Ready prompt, press Stop/Clear.
2 When the ringer sounds, press the telephone icon button.
3 If you hear a high-pitched fax signal, press Start.

The machine begins receiving the fax, and returns to a Ready prompt when finished.

Receiving a fax automatically
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Customizing settings

You can modify all the fax options using the operator panel menu. (See the following table for the
available options.)The Resolution option can be modified from either the operator panel menu or by
pressing the Resolution button. Settings selected using the operator panel menu become the default
settings and are in effect for all fax jobs. Settings selected using the Resolution button remain in effect until a
predefined Timeout period is expired. To change the Timeout period, see page 48.

To modify the Resolution setting for the current fax job, press Resolution repeatedly until the setting
you want appears on the display, and then press Select.

Note: See the table below for the recommended setting to select.

To modify all other fax options or to make your Resolution selection the default setting:

1 Press Menu.

2 Press ascroll button (<4 0r») until FAX SETUP appears on the top line of the display, and then
press Select.

Press a scroll button to scroll through the fax setup options.
4 When the option you want to change appears, press Select.

Change the setting by pressing a scroll button or enter a value using the numeric keypad, and
then press Select.

6 Repeat steps 3 through 5, as necessary.

7 To return to the Ready prompt, press Stop/Clear.

Note: Pressing Stop/Clear before pressing Select (step 5) cancels all settings for the
current job and returns them to their default status.

Option Description

Receive Mode | You can select the default fax receiving mode.
« In Automatic mode, the machine answers an incoming call and immediately goes into fax
reception mode.

* In Manual mode, you can receive a fax by pressing the telephone icon and then pressing
Start on the control panel when you can hear a fax tone from the remote machine.

Rings Specifies the number of times the machine rings (1 to 7) before answering an incoming call.

Resolution Used to improve the quality of faxes you send. Depending on the type of document you are
sending, select from the following settings:
« Standard - use for documents with normal sized characters.

* Fine - use for documents containing small characters or thin lines, or documents printed
using a dot-matrix printer.

» Super Fine - use for documents containing extremely fine detail. This setting is available
only if the fax machine you are sending to also supports the Super Fine resolution.

« Photo - use for documents containing shades of grey or photographs.
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Option Description

Darkness You can select the default Darkness setting to make the document you are faxing lighter or
darker. Select one of the following settings:

 Light - works well with dark print.
* Normal - works well with standard typed or printed documents.
« Dark -works well with light print or faint pencil markings.

Redials Specifies the number of redial attempts (0 to 13). If you enter 0, the machine will not redial.

Redial wait Specifies the number of minutes (1 to 15) to wait before automatically redialling a previously
busy fax number.

Ringer Specifies the volume (Low, Medium, or High) of the telephone ring for incoming faxes.

Speaker Specifies whether the speaker is On or Off. You can also set this option to Connect, which

turns the speaker on only until the receiving fax machine answers.

Confirmation A report showing whether the transmission was successful, how many pages were sent,
and so on. You can select from the following settings:

« On
o Off
« Error (prints only when a transmission is not successful).

Auto Report A report with detailed information about the previous 50 communications operations,
including dates and times. Available settings are On and Off.

Auto Reduce When receiving a document as long as, or longer than, the paper loaded in the paper tray,
the machine can reduce the size of the document to fit the size of paper loaded in the
machine. Select On if you want to automatically reduce an incoming page.

Select Off if you do not want the document reduced to fit onto one page. The document is
divided and printed in actual size on two or more pages.

Prefix You can set a prefix of up to five digits. This prefix is dialed before any autodial number is
started. It is useful for accessing the PABX exchange.

ECM The Error Correction Mode (ECM) compensates for poor line quality and ensures accurate,
error-free transmission with any other ECM-equipped fax machine. If the line quality is poor,
transmission time may be increased when ECM is enabled. Available settings are On and
Off.

Station ID This option, which includes the machine fax number and ID name, is set during initial setup,
however, if you move the machine to another location or get a new fax number, you may
need to modify the original settings.
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Using special features

The fax function includes some special features (phonebook, broadcast, and delay send) designed
to make faxing a document faster and easier. You can access these special features on the machine
operator panel or through the operator panel menus.

Phonebook

The phonebook is a directory of frequently used numbers that you can assign to specific keys for
quick dialing when sending a fax. These programmed numbers are called shortcuts. You can assign
multiple shortcuts into groups, so you can send the same fax to multiple numbers in a single job. Your
printer can hold 100 shortcuts or groups at one time.

Creating a shortcut

1

Press Phonebook until EDI T appears on the bottom line of the display, and then press
Select.

Press a scroll button until SHORTCUT appears on the bottom line of the display, and then press
Select.

Enter the shortcut location number on the numeric keypad, and then press Select.
The location can be any number between 0 and 99.

Using the keypad, enter the number that you want to store in the shortcut location, and then
press Select.

Using the alphanumeric feature of the keypad, enter an ID specific to the fax number. For
example: BOB' S FAX MACH NE.

To use the alphanumeric feature of the keypad, press the number key that corresponds to the
character that you want to use one or more times until the correct letter is displayed (for
example, press the number 2 three times to enter the letter C). Then, press the right scroll
button to move the cursor to the next space. Repeat until the name is entered.

Note: You can also enter special characters (+ - , . * [/ * # &) by pressing the 0
(zero) key.

Press Select.

To return to the Ready prompt, press Stop/Clear.
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Editing a shortcut

1

5

Press Phonebook until EDI T appears on the bottom line of the display, and then press
Select.

Press a scroll button (<0r») until SHORTCUT appears on the bottom line of the display, and
then press Select.

Enter the location of the shortcut that you want to edit.

Press the scroll buttons to edit the fax number, or press Select to edit the shortcut ID. When
finished, press Select to return to the Phonebook menu.

To return to the Ready prompt, press Stop/Clear.

Creating a group

1

Press Phonebook until EDI T appears on the bottom line of the display, and then press
Select.

Press a scroll button until GROUP appears on the bottom line of the display, and then press
Select.

Press a scroll button until NEWappears on the bottom line of the display, and then press
Select.

Enter the group location number on the keypad, and then press Select.

The location can be any location number between 0 and 99 that is not already occupied by
another shortcut or group.

Enter the location number for each shortcut that you want to include in the group, and then
press Select.

After each shortcut is entered, the display shows the shortcut’s stored fax number and ID.
Press Select to add another shortcut to the group.

Once all of the shortcuts have been added, press Return.

Enter an ID for the group using the alphanumeric feature of the keypad, and then press
Select.

Editing a group

1

Press Phonebook until EDI T appears on the bottom line of the display, and then press
Select.

Press a scroll button (< 0r'») until GROUP appears on the bottom line of the display, and then
press Select.

Press a scroll button until EDI T appears on the bottom line of the display, and then press
Select.
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4 Using the keypad, enter the location of the group that you want to edit.

5 Enter the location of the shortcut that you want to edit and press Select, or press Return to
edit the group ID.

(o]

Press Select.

7 To return to the Ready prompt, press Stop/Clear.

Using shortcuts and groups

1 Place your document in either the ADF or on the scanning bed.

2 Using the keypad, press and hold the shortcut number for the fax number that you want to
send to until the fax number and ID are displayed on the operator panel. For two-digit shortcut
numbers, press the first digit, and then press and hold the second digit.

Broadcast

Using the Broadcast feature, you can send a fax to multiple numbers without having to program the
numbers into the phonebook.

Note: You cannot broadcast to shortcuts.

1 Press Menu until FAX MENU appears on the top line of the display, and then press Select.

2 Press the scroll button until BROADCAST appears on the bottom line of the display, and then
press Select.

3 Enter the fax number that you want to send to, and then press Select.

The operator panel prompts you for another number.

4 Using the numeric keypad, press 1 (for Yes) if you have another number, or 2 (for No) if you
have entered the last number.
Delay send
Using the delay send feature, you can scan a document now and fax it at a later time.
Note: If your machine loses power, all delayed jobs are canceled.

1 Place your document in either the ADF or on the scanning bed.

2 Press Menu.

3 Press a scroll button (€4 0r») until FAX MENU appears on the top line of the display, and then
press Select.
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9

Press a scroll button until DELAY SEND appears on the bottom line of the display, and then
press Select.

Enter the fax number to which you want to send, and then press Select.
The operator panel prompts you for another number.

Using the numeric keypad, press 1 (for Yes) if you have another number, or 2 (for No) if you
have entered the last number.

When you have entered the last number, use the alphanumeric feature of the numeric keypad
to enter a name description for the fax job, and then press Select.

To use the alphanumeric feature of the keypad, press the number key that corresponds to the
character that you want to use one or more times until the correct letter is displayed (for
example, press the number 2 three times to enter the letter C). Then, press the right scroll
button to move the cursor to the next space. Repeat until the name is entered.

Note: You can also enter special characters (+ - , . * [/ * # &) by pressing the 0
(zero) key.

Enter the time that you want the fax to be sent, and then press Select.
Your document is scanned to memory.

To return to the Ready prompt, press Stop/Clear.

Canceling a pending job

1
2

Press Menu.

Press a scroll button (< 0r») until FAX MENU appears on the top line of the display, and then
press Select.

Press a scroll button until Cancel appears on the bottom line of the display, and then press
Select.

Press a scroll button until you see the job that you want to cancel, and then press Select.

Press 1 to verify that you want to cancel the job or 2 to return to the Fax menu.
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Clearing display messages

Display Meaning Solutions
Cancel ? The memory is full and unable to | To cancel the fax job, press 1 (for
store all the pages of the Yes).
document. If you want to send the pages that
were stored, press 2 (for No).
Note: You should send the
remaining pages later when
memory is available.
COW  ERRCR Facsimile communication problem | Ask the sender to resend the fax.

has occurred.

Functi on I npossi bl e

You have tried to use a
combination of machine functions
that cannot be used at the same
time.

Reduce the number of selected
functions or use only one function
at a time.

QG oup not avail abl e

You have tried to select a group
location number where only a
single location number can be
used, such as when adding
locations for a broadcasting
operation.

Use a shortcut number or dial a
number manually using the
numeric keypad.

Li ne Busy The remote party did not answer or | Resend the fax. If the problem
the line is already engaged. persists, wait for the line to clear,
and then resend the fax again.
LI NE ERROR Cannot connect with the remote Resend the fax. If the problem
machine, or lost contact because | persists, wait for the line to clear,
of a problem with the phone line. and then resend the fax again.
Or, turn the ECM mode on.
Menory Ful | The memory is full. Delete unnecessary documents,
retransmit after more memory
becomes available, or divide the
transmission into multiple jobs.
No answer The remote fax machine has not Resend the fax. Make sure that the
answered after several redial remote machine is operational.
attempts.
Not Assi gned The shortcut location has no Dial the number manually using

number assigned to it.

the numeric keypad or assign the
number. See “Creating a shortcut”
on page 56.

peration Not Assigned

You attempted to perform an
unsupported operation.

Retry Redial ?

Awaiting a specified time interval
to redial a previously busy station.

Wait for the machine to redial after
the specified time interval has
passed, press Select to
immediately redial, or Stop/Clear
to cancel the redial operation.

Stop pressed

The Stop/Clear button is pressed
during transmission.

Resend the fax.
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@ Reports

\V -

Your machine can print reports containing a wide range of important information. Here are some
examples of the different types of reports:

Report Content

Phonebook Current shortcuts and groups stored in the
machine.

Sent Most recent faxes sent.

Received Most recent faxes received.

Pending Pending fax jobs that have been entered using
the Delay Send feature.

Confirmation Faxes that have been confirmed received.

Settings Current default settings.

Power Falil « Time the power failed.

» Delay Send jobs that were deleted during the
power failure.

» Received faxes that were erased during the
power failure

 Failed jobs that were in the process of being
sent or received.

To print a report:

1 Press Menu.

2 Press a scroll button (<0r») until REPORT MENU appears on the top line of the display, and
then press Select.

3 Press a scroll button until the type of report that you want to print appears on the bottom line
of the display, and then press Select.

Reports
61



9 Maintenance

\V -

Cleaning the machine

To maintain print quality, follow these cleaning procedures each time the toner cartridge is replaced
or if print quality problems occur.

Warning:

« Do not put water directly onto any part of the machine.
+ Do not use ammonia-based cleaners or volatile solvents, such as thinner, on
the machine.

« While cleaning the inside of the machine, be careful not to touch the transfer
roller located under the toner cartridge. Oil from your fingers can affect print
quality.

Cleaning the outside of the machine

Wipe the outside surface of the machine with a soft, clean, lint-free cloth. If you dampen the cloth
slightly with water, be careful not to let any water drip onto or inside the machine.
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Cleaning the inside of the machine

During the printing process, paper, toner, and dust particles can accumulate inside the machine. This
buildup can cause print quality problems, such as toner specks or smearing. Cleaning the inside of

the machine eliminates or reduces these problems.

1 Turn the machine off, unplug the power cord, and then wait for the machine to cool down.

2 Open the front cover and remove the toner cartridge.

Warning: Do not touch the photoconductor drum located on the bottom of the toner cartridge.

Place the toner cartridge on a clean, dry surface.
4 With a dry, lint-free cloth, wipe away any dust and spilled toner from the toner cartridge area
and the toner cartridge cavity.

Warning:

To prevent damage to the toner cartridge, do not expose it to light for more
than a few minutes. Cover it with a piece of paper, if necessary.

+ Do not touch the black transfer roller.

Cleaning the machine
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5 Reinsert the toner cartridge and close the cover.

6 Plug in the power cord and turn the machine on.

Cleaning the scan unit

Keeping the scan unit clean helps ensure the best possible copies. You should clean the scan unit as
needed.

To clean the scan unit:
1 Slightly dampen a soft, lint-free cloth or paper towel with water.
2 Open the document cover.

3 Wipe the surfaces of the document glass and ADF until they are clean and dry.

4 Wipe the underside of the white document cover and white sheet until it is clean and dry.

5 Close the document cover.

Maintaining the toner cartridge

The life of the toner cartridge depends on the amount of toner that jobs require. If you are using
dense paper or processing a lot of graphics, you may need to change the cartridge more often.
Before changing the cartridge, try redistributing the toner or cleaning the photoconductor drum first.
For help, see pages 65 and 68.
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Redistributing toner

When the toner cartridge is near the end of its life, white streaks or light print occurs. The Toner Low
indicator lights up and the LCD displays the message TONER LOWV

To temporarily reestablish print quality by redistributing the remaining toner in the cartridge:

1 Open the front cover.

2 Pull the toner cartridge out, and then gently shake the cartridge to distribute the toner evenly.

Note: If the toner gets on your clothing, wipe it off with a dry cloth and wash clothing in
cold water. Hot water sets the toner into fabric.

3 Reinstall the cartridge and close the front cover.

Ordering toner cartridges

Within the United States or Canada, order a toner cartridge (P/N 185S0090) from any authorized
Lexmark supplies dealer. To locate the dealer nearest you, call 1-800-438-2468. In other countries,
contact the place where you bought your machine. You can also visit our web site,
www.lexmark.com.
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Replacing the toner cartridge
If the toner runs out, the message TONER EMPTY appears on the display and blank pages print.
Note: Incoming faxes will not print if this message appears.

To replace the toner cartridge:

1 Open the front cover.

2 Pull the toner cartridge out.

Note: Return the empty toner cartridge to Lexmark for appropriate environmental
handling. See page 68 for more information.
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3 Unpack the toner cartridge and gently shake it horizontally four or five times to distribute the
toner evenly.

Note: Save the packaging, and use it to return your empty cartridge to Lexmark. For more
information, see page 68.

4 Slide the toner cartridge in until it locks into place.

5 Close the front cover.
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Returning the empty toner cartridge

Using the Lexmark Cartridge Return Program is a free and easy way to return cartridges directly to
Lexmark for appropriate environmental handling.

Place the empty cartridge into the box from the new replacement cartridge. Reseal the box with clear
packing tape, and then apply a prepaid return shipping label. (The shipping label is available online
at www.lexmark.com/or at no cost to you.)

Note: Details may vary by country, but the program is always available at no charge. Visit
our web site, www.lexmark.com/or for country-specific instructions. You can also
contact your Lexmark representative or the place where you bought your machine
for information on the program.

Cleaning the photoconductor drum

If there are streaks or spots on your print, the photoconductor drum may require cleaning. Your
operator panel menu includes a Clean Drum option that may help to improve the print quality.

To clean the photoconductor drum:

1 Make sure paper is loaded.

2 Press Menu until MACH NE SETUP appears on the top line of the display, and then press
Select.

3 Press the scroll button € 0r» until CLEAN DRUM appears on the bottom line of the display,
and then press Select.

The machine prints out a cleaning page. Toner particles on the photoconductor surface are
affixed to the paper.

If the problem persists, repeat these steps.

If you have cleaned the photoconductor drum several times and the problem is still unresolved, install
a new toner cartridge.
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@ Troubleshooting
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Preventing document and paper jams

Follow these tips to help prevent document and paper jams.
e Use only recommended print materials.
« Do not mix paper types in the paper tray.
e Do not use creased, damp, or curled paper.
* Flex, fan, and straighten the paper before loading.
» Make sure the adjustable paper guides are positioned correctly.

» Make sure the recommended print side has the correct orientation when loading paper in the
paper tray and the manual bypass.

* Do not overload the paper tray. The paper should be below the max fill line on the inside wall
of the paper tray.

« Do not remove the paper from the tray while printing.

If a document or paper jam occurs, see “Clearing document jams” on page 70 or “Clearing paper
jams” on page 73.
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Clearing document jams
The message DOCUMENT JAMappears on the display if a document jams while feeding through the
ADF.
ADF misfeed
1 Open the ADF top cover

CAUTION: Keep hair and personal articles away from moving parts to avoid getting them
caught in the roller.

Clearing document jams
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2 If more than one inch of your document has passed beneath the ADF roller, close the ADF
top cover, and then proceed with the instructions for clearing a jam in “Roller misfeed” on
page 72.

If an inch or less is engaged in the ADF, gently pull the document out.

3 Close the ADF top cover, and then load the documents back into the ADF.

Note: To prevent document jams, use the document glass, rather than the ADF, for thick,
thin, or a mixed set of documents.
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Output misfeed

1 Open the document cover and turn the release knob to remove the misfed documents from
the exit area.

2 Close the document cover, and then load the documents back into the ADF.

Roller misfeed

1 Open the document cover and turn the release knob to so that you can easily access the
misfed document.

2 Remove the document from the ADF or the feed area by carefully pulling it with both hands.

3 Close the document cover, and then load the document back into the ADF.
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Clearing paper jams

The message PAPER JAMappears on the display if paper loaded in the output tray jams during
processing. Use the following table to locate and clear the paper jam.

Message Location of jam Go to...
PAPER JAM 0 Paper feed area page 73
PAPER JAM 1 Paper exit area page 75
PAPER JAM 2 Fuser and toner cartridge | page 77
areas
BYPASS JAM Manual bypass area page 78

Note: To avoid tearing the paper, pull the paper out gently and slowly.

Paper feed area (PAPER JAM 0)

1 Open and close the front cover. The jammed paper automatically exits the machine.
If the paper does not exit, continue with step 2.

2 Pull the paper tray open.
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3 Remove the jammed paper by gently pulling it straight out.

4

If there is any resistance when you pull the paper, or the paper is not seen in this area,
continue with the instructions for clearing a jam in the fuser and toner cartridge areas on

page 77.

Insert the paper tray until it snaps into place.
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5 Open and close the front cover to resume printing.

Paper exit area (PAPER JAM 1)

1 Open and close the front cover. The jammed paper automatically exits.
If the paper does not exit, continue with step 2.

2 Gently pull the paper out of the front output tray.
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3 If there is any resistance when you pull the paper, or the paper is not seen in the front output
tray, open the rear cover.

5 Close the rear cover.

6 Open and close the front cover to resume printing.
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Fuser and toner cartridge areas (PAPER JAM 2)

CAUTION: The fuser area is hot. Avoid contact with the fuser area to prevent burns.

1 Open the front cover and remove the toner cartridge.
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Manual bypass area (BYPASS JAM

The message BYPASS JAMappears on the display if paper is loaded improperly in the manual
bypass.

To clear a jam in the manual bypass:

1 Remove the jammed paper by gently pulling it straight out.
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Clearing display messages

Display Meaning Solution
BYPASS JAM No feeding from the manual Load paper in the manual bypass
bypass. or remove the jam from the manual
bypass.

DOCUMENT JAM Jam in the ADF. Clear the jam.

DOCR CPEN Front or rear cover is not securely | Close the covers until they lock.

latched.

FUSER ERROR Problem in the fuser unit. Unplug the power cord and plug it
back in. If the problem persists,
call for service.

LQAD BYPASS No document loaded in the manual | Load print media into the manual

bypass. bypass and try again.

LSU ERRCR A problem in the LSU (laser Unplug the power cord and plug it

scanning unit). back in. If the problem persists,
call for service. See page 89.

Menory Ful | Collated copy is too large for Reduce the number of pages in

memory. the job.

NO CARTRI DCGE Toner cartridge is not installed. Install the toner cartridge.

NO PAPER No paper in the paper tray. Load paper. See page 24.

PAPER JAM 0 Paper jam in the feeding area of Clear the jam. See page 73.

the paper tray.
PAPER JAM 1 Paper jam in the paper exit area. Clear the jam. See page 75.
PAPER JAM 2 Paper jam in the fuser and toner Clear the jam. See page 77.

cartridge areas.

PONER FAl LURE

Power interruption and the
machine’s memory is not saved.

Restart the job you were trying to
process before the power failure.

TI ME/ DATE pr onpt

Prompt appears when the machine
is powered on.

See “Setting the date and time” on
page 16.

TONER EMPTY Toner cartridge has run out. Install a new toner cartridge. See
page 65.
TONER LONV Toner is near empty. Remove the toner cartridge and

gently shake it. This temporarily
reestablishes printing.

Solving problems

The following tables list some problems you may experience and the suggested solutions. If the
problem persists after all suggested solutions have been exhausted, call for service. (See page 89.)
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Paper feeding problems

Symptom Possible cause and solution

Paper jam. Clear the paper jam. See page 73.

Paper sticks together. » Ensure that there is not too much paper in the paper tray. Depending on
the thickness of your paper, the paper tray can hold up to 250 sheets of
paper.

» Make sure that you are using the correct type of paper. See page 21.
» Remove paper from the paper tray and flex or fan the paper.
» Humid conditions may cause some paper to stick together.

Multiple sheets do not feed. « Different types of paper may be stacked in the paper tray. Load paper of
only one type, size, and weight.

» When loading paper, do not force the paper down into the machine.

 If multiple sheets have caused a paper jam, clear the paper jam. See
page 73.

Paper skews or buckles. » Ensure there is not too much paper in the paper tray. Depending on the
thickness of your paper, the paper tray can hold up to 250 sheets of
paper.

» Make sure the paper guide lightly touches the paper and does not cause
the paper to bow in the paper tray.

» Make sure you are using the correct type of paper. See page 21.

Paper does not feed. » Paper is not loaded correctly. Remove paper from the tray and reload it
correctly.

e There is too much paper loaded. Remove excess paper from the tray.
» The paper is too thick. Use only paper that meets specifications.
» Remove any obstructions.

Paper keeps jamming. » There is too much paper loaded. Remove excess paper from the tray. If
printing on special materials, use the manual bypass.

» Anincorrect type of paper is being used. Use only paper that meets
specifications. See page 21.

» There may be debris inside the machine. Open the front cover and
remove the debris.

Transparencies stick together | Use only transparencies specially designed for a laser printer. Remove
in the paper exit. each transparency as it exits the machine.

Envelopes skew or fail to feed | Ensure that the manual bypass guides are against both sides of the
correctly. envelopes.
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Printing and copying problems

Problem

Machine does not
print.

Possible cause

Machine is not receiving
power.

Solution

» Check the power cord connections.
» Check the power switch and the power source.

Machine is busy scanning.

Wait until scanning is complete before using the
printer.

Machine is not selected as
the default printer.

Select Lexmark X215 as your default printer in
Windows.

Front or rear covers are not
closed.

Close the covers.

Paper jam.

Clear the paper jam. See page 73.

No paper loaded.

Load paper. See page 21.

Toner cartridge is not
installed.

Install the toner cartridge. See page 11.

Connection cable between
the computer and the
machine is not connected

properly.

Disconnect the printer cable, and then reconnect it.

Connection cable between
the computer and the
machine is defective.

« If possible, attach the cable to another computer
that is working properly and print a job.

« Try a new printer cable.

Port setting is incorrect.

» Check the Windows printer setting to make sure
that the print job is sent to the correct port, for
example, LPT1.

* If the computer has more than one port, make sure
that the machine is attached to the correct one.

Configuration incorrect.

Ensure the printer settings are correct.

Machine is malfunctioning.

Check the display message on the operator panel to
determine if the machine is indicating a system error.

Print job is extremely
slow.

Job may be very complex.

« Reduce the complexity of the page.
» Adjust the print quality settings.

If using Windows 98/Me, the
Spool setting may be set
incorrectly.

1 Click Start » Settings » Printers.

2 Right-click the Lexmark X215 printer icon.
3 Click Properties.

4 From the Details tab, click Spool Settings.
5 Select the spool setting you want.

Half the page is
blank.

Page orientation setting may
be incorrect.

Change the page orientation in your program. See
page 31.

Paper size and the paper size
settings do not match.

Ensure that the paper size in the printer driver
settings matches the paper in the tray.

Solving problems
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Problem

Machine prints, but
the text is wrong,
garbled, or
incomplete.

Possible cause

Printer cable is loose or
defective.

Solution

» Disconnect the printer cable, and then reconnect it.

» Try a print job that you have already printed
successfully.

« If possible, attach the cable and the machine to
another computer and try another print job.

» Try a new printer cable.

Wrong printer driver selected.

Check the program’s printer selection menu to ensure
that your machine is selected.

Software program is
malfunctioning.

Try printing a job from another program.

Operating system is
malfunctioning.

» Exit Windows and restart the computer.
» Turn the machine off and then back on again.

Blank pages print.

Toner cartridge is defective or
out of toner.

» Redistribute the toner. See page 64.
 If necessary, replace the toner cartridge.

File may have blank pages.

Check the file to ensure that it does not contain blank
pages.

Some parts, such as the
controller or the board, may
be defective.

Contact a service representative.

lllustrations print
incorrectly in Adobe
lllustrator.

The setting in the software
program is wrong.

Print the document with Download as Bit Image
selected in the Advanced Options window of the
graphic properties.

Error occurs
repeatedly when
printing with the USB
connection.

When the USB mode is set to
FAST, some users may
experience poor USB
communication.

Change the USB mode to SLONV
1 Press Menu.

2 Press the scroll button (<4 Or») until MACH NE
SETUP appears on the top line of the display, and
then press Select.

3 Press the scroll button until USB appears on the
bottom line of the display, and press Select.

4 Press the scroll button until SLON appears on the
bottom line of the display, and press Select.

5 To return to the Ready prompt, press Stop/Clear.

LCD does not turn
on.

Machine is not receiving
power.

» Check that the machine is plugged into a properly
grounded electrical outlet.

» Ensure that there is power to the outlet and that the
machine power switch is in the On position.

Copies are too light
or too dark.

« If the original is light, press Darkness to darken the
background of the copies.

« If the original is dark, press Darkness to lighten the
background of the copies.

Smears, lines,
marks, or spots on
copies.

Document glass or document
cover is dirty.

« If defects appear on the original, press Darkness to
lighten the background of your copies.

 If no defects appear on the original, clean the
document glass and underside of the document
cover. See page 64.
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Problem

Possible cause

Solution

Copy image is Original document not » Ensure the original is positioned correctly on
skewed. positioned correctly. document glass or that ADF paper guides are
aligned. See page 49.
e Check that paper is loaded correctly.
Blank copies. Original document not Ensure that the original is facedown on the document

positioned correctly.

glass or faceup in the ADF.

Image rubs off the

» Ensure the correct media type is selected.

copy easily. » Replace paper with a fresh supply.
 In high humidity areas, do not leave paper in the
machine for extended periods of time.
Frequent jams. » Check/adjust paper guides.

» Fan the stack of paper, and then turn it over in the
paper tray.

» Replace paper with a fresh supply.

» Ensure the paper is the proper paper weight. 20 Ib
(75 g/m?) bond paper is recommended.

» Check for paper or pieces of paper remaining in the
machine after a jam is cleared.

Fewer copies from
the toner cartridge
than expected.

 Originals contain pictures,
solids, or heavy lines.

 Originals are forms,
newsletters, books, and so
on.

e The machine is being
turned on and off
frequently.

* The document cover is
being left open while
copies are being made.

Ensure document cover is closed when making
copies.
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Scanning problems

Problem Possible cause and solution

Scanner does not work. » Your machine may be busy printing. Wait until printing completes before
using the scanner.

» Make sure that you place the document to be scanned face down on the
document glass, or face up in the Automatic Document Feeder.

» Check that the USB or parallel cable is connected properly.

» Check that the USB or parallel cable is not defective. Swap the cable with
a known good cable. If necessary, replace the cable.

« If using a parallel cable, ensure that it is compliant with the IEEE-1284
standard.

» Make sure that the scanner job is being sent to the correct port (for
example, LPT1 or USB).

Scans very slowly. » Check if the machine is printing receiving data. Scan the document after
the current job is completed.

» Graphics are scanned more slowly than text.

« Communication speed becomes slow in scan mode because of the large
amount of memory required to analyze and reproduce the scanned
image. Set your computer to ECP printer mode through BIOS setting. It
helps to increase the speed. For details on how to set BIOS, refer to your
computer user documentation.

Faxing problems

Problem Possible cause and solution

Machine is not working, no e Unplug the power cord and plug it in again.

\?vlgrpll?r)l/g and buttons are not | . Ensure that there is power to the electrical outlet.

No dial tone. » Check that the phone line is connected properly.
» Check that the phone socket in the wall is working by plugging in another
phone.
Numbers stored in the Make sure that the numbers are stored in the memory correctly. Print a
memory do not dial correctly. | phonebook list.
Document does not feed. » Make sure that the document is not wrinkled and you are putting it in
correctly.

» Check that the document is the correct size, not too thick or too thin.
» Make sure that the ADF cover is firmly closed.

Faxes are not received » Make sure Receive mode is set to Automatic on the FAX SETUP menu.
automatically. « Make sure that there is paper loaded.
» Check that the display does not show MEMORY FULL.
Machine does not send. * Make sure that the document is loaded in the ADF or on the document
glass.

» Make sure the fax machine you are sending to can receive faxes.
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Problem Possible cause and solution

Incoming fax has blank spaces |« Fax machine sending you the fax may be faulty.

or isl_received with a poor « Fax machine sending you a fax may have a dirty document glass. Clean
quality. the document glass.

» Noisy phone line can cause line errors.
» Check your machine by making a copy.
» Toner cartridge may be empty. Replace the toner cartridge.

Some of the words on a Fax machine sending you the fax had a temporary jam.
incoming fax are stretched.

There are lines on the Check your scan glass for marks and clean it.
documents you send.

Machine dials a number, but The other fax machine may be turned off, out of paper, or cannot answer
fails to make a connection with | incoming calls. Ask the receiving fax recipient to solve the problem.
another fax machine.

Documents are not stored in There may not be enough memory to store the document. If the display
memory. shows a MEMCRY FULL message, delete any documents you no longer need
from the memory, and then restore the document.

Blank areas appear at the You may have chosen the wrong paper settings.
bottom of each page or on

other pages, with only a small
strip of text printed at the top.
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Print quality problems

Problem Solution

Light or faded print If a vertical white streak or faded area appears:
» The toner supply is low. You may be able to temporarily extend the toner
Aa-hCc cartridge life. See page 64.
Aa=hCc If this does not improve the print quality, install a new toner cartridge.
Aa=bCc » The paper may not meet paper specifications (for example, paper is too
Aa~hHhCc moist or too rough). See page 22.
Aa~hCc « If the entire page is light, the print resolution setting is too light. Adjust the

darkness and content. See page 45.

» A combination of faded or smeared defects may indicate that the toner
cartridge needs cleaning. See page 68.

Toner specs » The paper may not meet specifications (for example, the paper is too
— moist or too rough). See page 22.
AaBbCc « The paper path may need cleaning. See page 63.
Aa > -.'CC:.
AaBbCc
Dropouts If faded areas that are generally rounded occur randomly on the page:
» A single sheet of paper may be defective. Try reprinting the job.

AaBbQC » The moisture content of the paper is uneven, or the paper has moist
AaBbCc spots on its surface. Try a different brand of paper. See page 21.
AaBbCc » The paper lot may be defective. The manufacturing processes can cause
AaBRbCc some areas to reject toner. Try a different brand of paper.

. » The toner supply is low. You may be able to temporarily extend the toner
AaBbCc cartridge life. See page 64.

If this does not improve the print quality, install a new toner cartridge.
« If these steps do not correct the problems, contact a service

representative.
Vertical lines If white or black vertical streaks appear on the page, the drum inside the
toner cartridge has probably been scratched. Install a new toner cartridge.
AgBbCG See page 65.
AaBbCc
AaBbCc

NaBbCd
AaBb(Cd

L
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Problem Solution

Gray background If the amount of background shading becomes unacceptable, the
procedures below may fix the problem.
AaBbCc » Use lighter weight pages. See page 21.
AaBbCc « Check the machine’s environment. Very dry (low humidity) or humid
AaBbCc (higher than 80% RH) conditions can increase the amount of background
shading.

AaBbCc * Install a new toner cartridge. See page 65.

AaBbCc

Toner smear » Clean the inside of the machine. See page 63.

» Check the paper type and quality. See page 21.
AaBch * Install a new toner cartridge. See page 65.
AaBhCc
AaBhCc
AaBbCc
AaBbCc
Repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:
= » The toner cartridge may be damaged. If a repetitive mark occurs on the

AaBbCc page, print a cleaning sheet several times to clean the cartridge. See

AaBbCc_ page 68.

AaBbCc After the printout, if you still have the same problems, install a new toner

AaBbCc cartridge. See page 65.

AaBbCC7 » Parts of the machine may have toner on them. If the defects occur on the
back of the page, the problem will likely correct itself after a few more
pages.

» The fusing assembly may be damaged. Contact a service representative.
Background scatter Background scatter results from bits of toner distributed on the printed

page.
» The paper may be too damp. Try printing with a different batch of paper.

Do not open packages of paper until necessary so that the paper does
not absorb too much moisture.

* If background scatter occurs on an envelope, change the printing layout
to avoid printing over areas that have overlapping seams on the reverse
side. Printing on seams can cause problems.

« If background scatter covers the entire surface area of a printed page,
adjust the print resolution through your software program or the printer

properties.
Misformed characters « If characters are improperly formed and producing hollow images, the
paper stock may be too slick. Try a different paper. See page 21.
AaBbCc * If characters are improperly formed and producing a wavy effect, the
AaBbCc scanner unit may need service. Contact a service representative.
AaBbCc
AaBbCc
AaBbCc
AaBbCc
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Problem Solution

Page skew » Check the paper type and quality. See page 21.
» Ensure that the paper or other material is loaded correctly and the guides
ﬁaBbCC are not too tight or too loose against the paper stack. See page 21.
aBbc
aBbc
AaBbCC
aBbCc
Curl or wave e Check the paper type and quality. Both high temperature and humidity
can cause paper curl. See page 21.
AaBbgC . '{lérorl (I)r\]/?rr] éht(rea:;:ltack of paper in the paper tray. Also try rotating the paper
AagppCC '
AaspCC
AaspCC
AaspCC
\_/—‘

AaBbCc
AaBbCc

Ensure that the paper is loaded properly.

Check the paper type and quality. See page 21.

Turn over the stack of paper in the paper tray. Also try rotating the paper
180¢ in the tray.

Bac

k of printout is

AaBbCc
AaBbCc
AaBbCc
AaBbCc
BbCc

dirty

The transfer roller may be dirty. See page 62.
Check for leaking toner. Clean the inside of the machine. See page 63.

Black pages

The toner cartridge may not be installed properly. Remove the cartridge
and reinsert it.

The toner cartridge may be defective and need replacing. Install a new
toner cartridge. See page 65.

The machine may require repair. Contact a service representative.
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Problem

Loose toner

AaBb(Cc
AaBpCc
Aak3bCc
A Cc
Ad

Solution

Clean the inside of the machine.
» Check the paper type and quality. See page 21.
 Install a new toner cartridge. See page 65.

« If the problem persists, the machine may require repair. Contact a
service representative.

Character voids

Character voids are white areas within the parts of characters that should
be solid black:

 If you are using transparencies, try another type of transparency.
Because of the composition of the transparency, some character voids
are normal.

» You may be printing on the wrong surface of the paper. Remove the
paper and turn it over.

» The paper may not meet paper specifications. See page 21.

Horizontal stripes

AaBbCc
AaBbCc
AaBbCc
AaBbCc
A~DL/MNA
AdAdDLUOUUU

If horizontally aligned black streaks or smears appear:

» The toner cartridge may be installed improperly. Remove the cartridge
and reinsert it.

e The toner cartridge may be defective. Install a new toner cartridge. See
page 65.

« If the problem persists, the machine may require repair. Contact a
service representative.

Calling for service

When you call for service, describe the problem you are experiencing, the message on the display,
and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. Refer to the label on the back of the

machine for this information.

For service in the U.S. or Canada, call 1-800-Lexmark (1-800-539-6275). For other countries/
regions, refer to http://support.lexmark.com.
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' Notices

\V -

Safety information

» If your product is not marked with this symbol [O], it must be connected to an electrical outlet
that is properly grounded.

CAUTION: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the power cord or telephone,
during a lightning storm.

* The power cord must be connected to an electrical outlet that is near the product and easily
accessible.

» Refer service or repairs, other than those described in the operating instructions, to a
professional service person.

e This product is designed, tested, and approved to meet strict global safety standards with the
use of specific Lexmark components. The safety features of some parts may not always be
obvious. Lexmark is not responsible for the use of other replacement parts.

e Your product uses a laser.

CAUTION: Use of controls or adjustments or performance of procedures other than those
specified herein may result in hazardous radiation exposure.

e Your product uses a printing process that heats the print media, and the heat may cause the
media to release emissions. You must understand the section in this User’'s Guide that

discusses the guidelines for selecting print media (page 22) to avoid the possibility of harmful
emissions.

Conventions
It may help you to recognize the caution and warning conventions used in this document.
CAUTION: A caution identifies something that could cause you harm.

Warning: A warning identifies something that could damage your product hardware or
software.
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Laser notices
The following laser notice label may be affixed to this machine:

Laser advisory label

CALTIDN - BVISIBLE LASER RADNATION

WHEN THIS COVER OPEN,
[ MOT DPEN THES COVER,
WOASKCHE - UNSICHTBAAE LASERSTRAHLUNG,

VIZR ABDECKUMG GEAFFHET,
KICHT BEM STRARE AUSSETZEN.
ATTENTICHN - FLAYOHMEMENT LASER 1ViSIGLE BN CAZ
ErOUVERTURE. EXFOSITICH DONGEAEUSE
ALV FAISCEALL
ATTEMZIOHE - RADIAZICHE LASER IMWVIZIEILE 1N CASD O
APERTUEA, EVITARE L'ESPOERZIIME AL FAZCIO.
PRECAUCKIN - AADLACHIN LASES INVISIELE CLAKIO SE ABRE.
EVITAR EXPONERSE AL AR
PERIOD - RACIADSD LASSR INIEMEL 80 SBRIALENTE
EXPOSICAD DIRECTAAD FEXE,
GEVAAR - ONIOCHTBARE LASERSTRALEN Bar GEOFENDE
FLEF. DEZE BLEP HIET QIFEMEN.
ADVAHEEL. « USYHLNG LASEASTRAL LG YED ASMING, AR
SFXERHEOSERYDERE EF DS AF FUNKTION,
URDAA L2SAETTELES FOR STRALKING.
AUVARSEL « EISYMLIG LASERSETRALK MG MAR DEHSEL
APRES. STIRF [KEE NP 1 §TRALEM, UNNGA
ERSPONEAIMNG FOR STRALEN
VERMING - OSYRLAE LASERSTRALNIMG MAR DEMHA DEL
AR GFFEN CoM SAAREEM AR LRAKOFPLAD.
BETRAKTA E5 STRALEN. STRALEN AR FARLIG,
VARDL - RUATTAESSA LA SUDALUKITIE GHITETTAESSA
CAET ALTTUMA MESYIAT TOMALLE LAZER.
BATEELYLLE ALA KATSL SATEESEER.

- FRETLE HRMRRRN
- 0| BAEE 2 Ho|HRH Rl 5 eSE
FEEEHAR,

=
&=

1o &

AAS I BRAD

Laser notice

The machine is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J

for Class | (1) laser products, and elsewhere is certified as a Class | laser product conforming to the
requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The machine contains internally a Class
IlIb (3b) laser that is nominally a 5 milliwatt gallium arsenide laser operating in the wavelength region
of 770-795 nanometers. The laser system and machine are designed so there is never any human

access to laser radiation above a Class | level during normal operation, user maintenance, or
prescribed service condition.

Electronic emission notices

Federal Communications Commission (FCC) compliance information statement

The Lexmark X215 has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this
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device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference

in a residential installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the

interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for any radio or television interference caused by using other
than recommended cables or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a
Class B computing device, use a properly shielded and grounded cable such as
Lexmark part number 1329605 for parallel attach or 12A2405 for USB attach. Use
of a substitute cable not properly shielded and grounded may result in a violation
of FCC regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.

740 West New Circle Road

Lexington, KY 40550

(859) 232-3000

Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing
Equipment Regulations.

Avis de conformité aux normes de I'industrie du Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel
brouilleur du Canada.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 89/336/EEC,
73/23/EEC, and 1999/5/EC on the approximation and harmonization of the laws of the Member
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States relating to electromagnetic compatibility and safety of electrical equipment designed for use
within certain voltage limits and on radio equipment and telecommunications terminal equipment.

A declaration of conformity with the requirements of the directives has been signed by the Director of
Manufacturing and Technical Support, Lexmark International, S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

The United Kingdom Telecommunications Act 1984

This apparatus is approved under the approval number NS/G/1234/3/100003 for the indirect
connections to the public telecommunications systems in the United Kingdom.

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance
with ISO 9296.

1-meter average sound pressure, dBA

Copying 56 dBA
Scanning 53 dBA
Printing 54 dBA
Idling 40 dBA

ENERGY STAR

The EPA ENERGY STAR Office Equipment program is a partnership effort with office equipment
manufacturers to promote the introduction of energy-efficient products and to reduce air pollution
caused by power generation.

Companies participating in this program introduce products that power down when they are not
being used. This feature will cut the energy used by up to 50 percent. Lexmark is proud to be a
participant in this program.

As an ENERGY STAR Partner, Lexmark International, Inc. has determined that this product meets
the ENERGY STAR guidelines for energy efficiency.
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Telecommunications notices

Federal Communications Commission (FCC) compliance information statement

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the back of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to your telephone company.

This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.

A plug and jack used to connect this equipment to the premises’ wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See “Connecting the cables” on page 13 for more
information.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be
connected to a telephone line. Excessive RENs on a telephone line may result in the devices not
ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed
five (5.0). To be certain of the number of devices that may be connected to a line, as determined by
the total RENSs, contact your local telephone company. For products approved after July 23, 2001, the
REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier
products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. If advance notice is not practical,
the telephone company will notify the customer as soon as possible. You will also be advised of your
right to file a complaint with the FCC.

If trouble is experienced with this equipment, for repair or warranty information, please contact
Lexmark International, Inc. See “Calling for service” on page 89.

If the equipment is causing harm to the telephone network, the telephone company may request that
you disconnect the equipment until the problem is resolved.

This equipment contains no user serviceable parts. For repair and warranty information, please
contact Lexmark International, Inc. See the previous paragraph for contact information.

Connection to party line service is subject to state tariffs. Contact the state public utility commission,
public service commission, or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about
what will disable alarm equipment, consult your telephone company or a qualified installer.

Telephone companies report that electrical surges, typically lightning transients, are very destructive
to customer terminal equipment connected to AC power sources. This has been identified as a major
nationwide problem. It is recommended that the customer install an AC surge arrestor in the AC
outlet to which this device is connected. This is to avoid damage to the equipment caused by local
lightning strikes and other electrical surges.
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The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including fax machines, to send any message unless said message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message, and the telephone number of the sending machine or such
business, other entity, or individual. (The telephone number provided may not be a 900 number or
any other number for which charges exceed local or long-distance transmission charges.)

See “Setting the station ID” on page 17 in order to program this information into your fax machine.

Notice to users of the Canadian telephone network

This product meets the applicable Industry Canada technical specifications.

The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed
to be connected to a telephone interface. The terminus of an interface may consist of any
combination of devices, subject only to the requirement that the sum of the Ringer Equivalence
Numbers of all the devices does not exceed five. The modem REN is located on the rear of the
equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive
to customer terminal equipment connected to AC power sources. This has been identified as a major
nationwide problem. It is recommended that the customer install an AC surge arrestor in the AC
outlet to which this device is connected. This is to avoid damage to the equipment caused by local
lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.

Declaration of conformity (European countries)
EC Certification
Certification to 1999/5/EC Radio & Telecommunications Terminal Equipment Directive (FAX)

This product has been self-certified for pan-European single terminal connection to the analogue
Public Switched Telephone Network (PSTN) in accordance with Directive 1999/5/EC. The product
has been designed to work with the national PSTNs and compatible PBXs of the European
countries:

In the event of problems, you should contact Lexmark International Inc. in the first instance.

The product has been tested against TBR21. To assist in the use and application of terminal
equipment which complies with this standard, the European Telecommunication Standards Institute
(ETSI) has issued an advisory document (EG 201 121) which contains notes and additional
requirements to ensure network compatibility of TBR21 terminals. The product has been designed
against, and is fully compliant with, all of the relevant advisory notes contained in this document.

Using the Lexmark X215 in Germany

The Lexmark X215 requires a German billing tone filter (Lexmark part number 14B5123) to be
installed on any line which receives metering pulses in Germany. Metering pulses may or may not be
present on analog lines in Germany. The subscriber may request that metering pulses be placed on
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the line, or can have them removed by calling the German network provider. Normally, metering
pulses are not provided unless specifically requested by the subscriber at the time of installation.

Using the Lexmark X215 in Switzerland

The Lexmark X215 requires a Swiss billing tone filter (Lexmark part number 14B5109) to be installed
on any line which receives metering pulses in Switzerland. The Lexmark filter must be used, as
metering pulses are present on all analog telephone lines in Switzerland.
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Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc.,
registered in the United States and/or other countries.

© 2003 Lexmark International, Inc.

740 West New Circle Road

Lexington, Kentucky 40550

www.lexmark.com
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